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Abstract: Learn how to create basic content for publishing to the World 
Wide Web. Using Dreamweaver’s visual based interface, add 
text, images and files to your web pages as well as design the 
layout to your personal preference. You will also learn how to 
use Dreamweaver to edit existing pages and publish pages to the 
Internet. 
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Introduction 
Dreamweaver helps you create, modify publish and manage Web pages as well as 
organize them into a professional-quality Web site. The visual editing environment 
allows you to develop web pages without having to learn HyperText Markup Language 
(HTML) source code. 

Objectives 
Create, format, and publish a document ready for the World Wide Web. After today’s 
workshop, participants will be able to: 

 Insert and format text, including creating lists. 

 Incorporate graphical images into Web documents. 

 Use links to other pages or documents. 

 Upload (publish) completed documents to a Web server. 

Prerequisites 
It is assumed that the participants in this workshop have completed Dreamweaver: 
Getting Started workshop and/or are already familiar with Dreamweaver’s environment. 

Definitions 

Term Definition 

Download To download working copies of published pages to your local 
machine for editing. In Dreamweaver “get” (the green down arrow) 
downloads the file(s) to your local machine. 

HTML (HyperText 
Markup Language) 

The markup language of a document on the World Wide Web. 
HTML tags define the structure of text, graphics, and hyperlinking 
of a web page and are saved as plain text in a file. 

SFTP (Secure File 
Transfer Protocol) 

A method used to move files and folders from one computer to 
another over the Internet. Dreamweaver uses FTP to publish web 
content to the server. KU requires that you select the option for 
SFTP to publish pages to a KU server. 

Upload To transfer data to a central computer; also publish. In 
Dreamweaver “put” (the blue arrow) uploads the file(s) to the 
server. 

Dreamweaver uses FTP to upload web pages and content to the 
server. KU requires that you select the option for SFTP to publish 
pages to a KU server. 

URL (Uniform The URL is the address of a resource, or file, available on the 
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Resource Locator) Internet. The URL identifies the method of access, or protocol of 
the resource (e.g. http:// or ftp://), the domain name for the 
resource, and the hierarchical name for the file (address). For 
example, a page on the internet may be at the URL 
http://www.ku.edu/exchange/index.shtml. The beginning part, 
http://, provides the protocol; the next part, www.ku.edu, is the 
domain, where the main domain is ku.edu and www is a pointer to 
a specific web server or a location on a specific server. The rest, 
/exchange/index.shtml, references a specific folder (/exchange/) 
and a specific file (index.shtml) in that folder. 

Web server The computer that sends web browsers the web page content they 
request is also called the server; it has special software (Web 
server software) which gives it the ability to listen and respond to 
such requests. This server is where your published web page files 
actually reside. 

Dreamweaver refers to the web server as the remote site. 
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Brief Review: How web pages work 
Typing in a URL such as www.ku.edu initiates a request 
from your computer’s Web browser to a remote 
computer called a web server to read an HTML file that 
is stored there. The browser reads the code in the file 
and translates it into the graphics and text that you look 
at on your desktop. 

So, using Dreamweaver, you make HTML files on your 
computer and upload them to a remote computer that's 
connected to the Internet (the Web server) where anyone 
can request access to your files and view them on their 
local browser. 

Dreamweaver environment: Code View, 
Design View or both 

In Windows, Dreamweaver provides an all-in-one-
window integrated workspace. In the integrated 
workspace, all windows and panels are combined into a 
single larger application window. You can choose between a designer-oriented layout and 
a layout oriented toward the needs of HTML-coders. 

On the Macintosh, Dreamweaver provides a floating workspace layout, in which each 
document is in its own individual window. Panel groups are initially docked together, but 
can be undocked into their own windows. Windows “snap” automatically to each other, 
to the sides of the screen, and to the Document window as you drag or resize them. 

Opening a new document in Dreamweaver 
Dreamweaver presents splash screen with three categories of options from which to 
choose. For a new document, select HTML from the Create New category. If you are 
editing an existing document you may find it listed in the Open a Recent Item category. 

When you select HTML Dreamweaver’s HTML editor will default to XHTML 1.0 
Transitional markup language, the current standard for web development and is 
compatible with the KU Template. 
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File naming and page titles 
There are two labels associated with your web page. 

The file name is the name you give your file when you save it. Use a name that indicates 
the purpose of your web page (example: lesson_outline.html). 

Note: For purposes of posting files on the Internet, the name must begin with a 
letter or number, letters should be in lowercase, and may not contain any 
spaces. 

If you are saving your home page (first page of the site), you can simplify 
the Web address for your site by naming this document index.htm. 

The page title is the name you will specify in the Title field on the Document toolbar and 
that will typically appear in a browser window’s title bar. It can have upper case letters 
and spaces. 

File opened in Dreamweaver 

 

Same file opened in Internet Explorer 

 Page Title 

File name 
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Saving a Web page 
Saving a Web page with Dreamweaver is very similar to saving any other type of 
document. 

1. Click the File menu and choose Save. 

2. Navigate to the folder in which you want to save your web site documents. Type 
a name for your document in the File name: field.  

Note: Web document names must not contain spaces. If you are saving your 
home page (first page of the site), you can simplify the Web address for 
your site by naming this document index.shtm. See What is the URL of 
my home page? for further information. (This convention is specific to 
KU central Web servers and may not work on other Web servers). 

3. Choose HTML Documents from the Save as type: field (if necessary). 

4. Click Save. 

Inserting and Formatting Text 
Every item on your Web page, such as a paragraph, a heading, a list, or a table is some 
type of structural element. Use Dreamweaver to identify those elements. The following 
explanations assume that the Property inspector is displayed on your work area. (Click 
the Window menu and choose Properties to show the Property inspector if it is hidden.) 

 

Headings 

Web documents can have up to six levels of headings. Heading 1 indicates the most 
important heading while Heading 6 designates the lowest level heading. You use headings 
to designate the relative prominence of the information following them. Using Headings 
levels when formatting your web page is useful because it will allow you to make 
uniform changes across your website when you apply Cascading Style Sheets (CSS). 
(CSS is covered in the workshop Dreamweaver: Visual Design using CSS.) 

Add a heading 
To mark text as a heading, select the text and choose the desired heading level from the 
Format pop-up menu in the Property inspector, as shown below: 
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Note that the tag selector (in the status bar, lower left) now looks something like this: 

. Dreamweaver inserts these HTML tags in the document: <h1> at the 
beginning of the text designated as a level 1 heading, and </h1> at the end. 

Change a heading level 
To change a heading level, select the heading and choose the desired heading level from 
the Format field in the Property inspector. 

Remove a heading 
The heading designation can be removed in several ways: 

Place the cursor anywhere in the heading and choose None from the Format pop-up 
menu in the Property inspector. 

Right-click on the  in the tag selector and choose Remove Tag (with the left mouse 
button) as shown below: 

 

 

Paragraphs and Line Breaks 
A paragraph can be as little as one word, or even one character, or as much as a page 
full of text. Within Dreamweaver , designating a given piece of text as a paragraph has 
the effect of setting that text apart from surrounding items on the page by inserting one 
blank line between the paragraph and the element below it. 
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Create a paragraph 
To mark text as a paragraph, select the text and choose Paragraph from the Format pop-
up menu in the Property inspector, as shown below: 

Note: Dreamweaver is set to default to paragraph formatting when you type into a 
new document. 

 

Notice that the tag selector now looks something like this: . Dreamweaver 
inserts these HTML tags in the document: <p> at the beginning of the text designated as 
a paragraph, and </p> at the end. 

Remove a paragraph designation 
The paragraph designation can be removed in several ways: 

Place the cursor anywhere in the paragraph and choose None from the Format pop-up 
menu in the Property inspector. 

Right-click on the  in the tag selector and choose Remove Tag (with left mouse 
button) as shown below: 

 

Insert a line break 
A line break causes the browser to display all text that follows the line break designation 
on the next line. Place your cursor at the location at which you want the line break. Insert 
a line break using one of these methods: 

 Type Shift + Enter. 

 Click the Insert menu on the menu bar and choose HTML, then Special 
Characters, and then Line Break. 
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Dreamweaver inserts a <br /> HTML tag at the point at which you designated a line 
break. 

Insert a horizontal rule 
A horizontal rule is simply a horizontal line across the page. Determining how wide the 
line is, or its width or color is handled with CSS (not covered in this document). Place 
your cursor at the location at which you want the horizontal rule. Click the Insert menu, 
select HTML, and then select Horizontal Rule. Dreamweaver inserts an <hr /> HTML 
tag at the point at which you designated a horizontal rule. 

You can remove a horizontal rule by placing your cursor under the rule and using the 
Backspace key or by right-clicking on the horizontal rule and selecting Remove Tag 
<hr>. 

 

Lists 
HTML, and therefore Dreamweaver, allows for three types of lists: ordered 
(sequenced or numbered), unordered (bulleted), and definition. These list types can 
be nested to create lists within lists (sublists). We are only going to address ordered and 
unordered lists in this class. 

Note: If you intend to learn about and use CSS it will be important to know that lists 
come under the category of block-level elements. A block-level element is set 
off from items before and after it by a blank line. 

To create any type of list, it is important that each of the items in the list be designated as 
a paragraph first, before applying the list formatting. 

Important: Do not separate list items from one another using a line break. Just use the 
Enter key to separate the list items. 

Ordered (numbered) lists 
Use an ordered list when the sequence in which the items are presented is important. 



Instructional Services 
Dreamweaver: Creating Web Pages 

Instructional Services at KU Libraries - 11 - © 2009 The University of Kansas 
A Division of Information Services 

To create an ordered list, arrange the items in your list as sequential paragraphs as shown 
below: 

Item one 

Item two 

Item three 

Select all of the items in the list and do one of the following: 

• Click the numbered list button ( ) on the Property inspector. 

OR 

• Click the Format menu and select List, then choose Ordered List. 

 

 

Unordered (bulleted) lists 
Use an unordered list when the sequence in which the items are presented is not 
important. 

To create an unordered list, arrange the items in your list as sequential paragraphs as 
shown below: 

Red 

Purple 

Yellow 

Select all of the items in the list and do one of the following: 

• Click the bulleted list button ( ) on the Property inspector. 

OR 

• Click Format on the menu bar, choose List, then choose Unordered List. 
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Working with Images: GIFs, JPEGs, and PNGs 
Two types of file formats are almost universally supported by visual browsers: GIF and 
JPEG. Any image in one of these formats can be placed on a Web page. If you have a 
graphic you would like to use and it is in some other format (e.g., BMP, TIFF, PICT, 
etc.), convert the image to GIF or JPEG using a graphic converter program (several 
shareware programs are available for download from graphics Web sites) or a graphics 
program (e.g., Photoshop, Fireworks, Image Composer, Paint Shop Pro, Preview, etc.). 

Inserting images 
Unlike in other software applications such as Word and PowerPoint, images inserted in 
Web pages are not stored with the document when the file is saved. Image files remain 
separate from the HTML document and must be independently published to the Web 
server. As separate files, they are referenced by a file name in your Web document. 

For more information on uploading files to a Web server, see the section entitled 
“Publishing a Page with Dreamweaver”. 

To insert an image: 

1. Save your page if you haven’t already done so. 

Note: You can insert an image into an unsaved document, but if you do, a dialog 
box appears, informing you that the URL used for the image will be the full 
local path to the image. Dreamweaver fixes the URL later, when you do 
save the document, but it is easiest to save the document before adding 
images. 

2. Place your cursor at the point at which you want an image inserted. 

3. Click the Insert menu and select Image.  

 

 

4. Select the image file you want to insert. (If the file is not shown, browse to the 
proper folder to find the image.) 
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5. Click OK or Select (Windows) or Choose (Macintosh) to insert the image. The 
image appears in the Document window.  

Remember: The image is not stored as part of the page but remains a separate file 
that must be uploaded to the Web server separately. Dreamweaver 
will refer to the image as a dependent file. When uploading your 
website to the server you will want to include all dependent files. 

Every image must have alternative text associated with it for use by non-graphical 
browsers. The text should provide meaningful information about the purpose of the 
image on the page. If the image is purely decorative, enter an “empty” for the alternative 
text as described below. 

 

Positioning images – A quick and dirty method 
Ideally, the positioning of images is handled with CSS. However, there are some quick 
tricks to get an image relatively close to where you want it. When working with images 
on the Web, it is important to understand that images are aligned relative to the text next 
to which they are placed. That is, an image can be aligned relative to the baseline, middle, 
or top of text as shown in the following examples: 
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In addition, an image can float along the left or right of the block element in which it is 
placed. If you put an image inside a table cell, in a paragraph or simply inside the body of 
your document, it can float to either the right or left edge of its containing box. The 
examples below are images inside of paragraph elements.  

Note: The X marks the actual location of the image tag (<img … />) in the 
paragraph. 

 

X This image has an alignment value of “left.” That means that the browser 
fits as much text in the window as possible while leaving room for the image 
and aligns the image to the left of the associated text.  

X This image has an alignment value of “right.” That means that the 
browser fits as much text in the window as possible while leaving room for 
the image and aligns the image to the right of the associated text. 
Experiment with this by making your browser window narrower. Watch 
how that affects the image/text relationship.  

Get Connected - Hyperlinks 
Hyperlinks connect Web pages. Hyperlinks can connect pages that are part of the same 
Web site, or they can link to other Web sites. A hyperlink can consist of text or images 
that have been encoded such that when a site visitor invokes the text or image (usually by 
clicking) a new page of material is presented by the browser. 

External link A link to a Web page outside of your Web site. This type of 
link requires an absolute URL. 

Local link A link to another page within your site. While not required, 
lcaol links should use relative URLs. Dreamweaver will create 
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relative URLs by default. 

Named 
anchor link 

A link to a specific location within a page (other than the top of 
a page, which is the browser default). 

Email link While not technically a hyperlink (in that clicking an email link 
does not cause a new page of information to be opened in a 
browser), an email link causes the default email program on the 
viewer’s computer to open, and inserts the email address 
specified in the link in the To: field of a new email message. 

Making links 
Regardless of the type of link, making links involves two main steps: 

• Identify the text or image that is to serve as the link. For text links, choose the 
wording for the link carefully so as to clearly identify the target of the link. 
“Click here” is not a useful phrase for those who listen to a list of available links 
on a page. 

• Identify the location of the page that is to open in the browser when the link is 
invoked. 

Linking to outside resources 
Use the method described in this section to link to a Web page that is not part of your 
own site. That is, to link to another Web site. 

To create such a link, select the text or image that is to serve as the link. Select text by 
clicking and dragging across it, or select an image by clicking on it: 

 

Then, in the Link field of the Property inspector, type the Web address (URL) of the site 
or page to which you want to link. 

 

Linking within your site 
Use a local link in order to link pages of your own site together. The document being 
linked can be in the same folder as the current document or in another folder in your site. 
The most common local link to include is the one that takes you back to the site’s 
home page. 



Instructional Services 
Dreamweaver: Creating Web Pages 

Instructional Services at KU Libraries - 16 - © 2009 The University of Kansas 
A Division of Information Services 

Because such links refer to other saved documents on your computer, you should always 
save a new document before creating local links. 

To create a local link: 
Select the text or image that is to serve as the link. Select text by clicking and dragging 
across it, or select an image by clicking on it. 

Then, in the Link field of the Property Inspector, enter the Web address (URL) of the 
page to which you want to link in one of the following ways: 

Type the path, if any, and filename directly into the Link field in the Property 
inspector. 

OR Browse to the file: 

1. Locate the file by clicking on the folder icon. 

 

2. Navigate your way to the file to which you want to link. 

3. Select the file name. 

4. Click Select (Windows) or Choose (Macintosh). 

OR Drag from the Point-to-File icon ( ) to another open document or a file in the 
Files panel. 

Note: You can link to an open document only if your documents are not 
maximized in the Document window. When you point to an open 
document, that document moves to the foreground of your screen 
while you are making your selection. 

Linking to a specific place within a page 
Use a named anchor link to connect parts of the same Web page, or to link to a specific 
point in another Web page (rather than having the page display begin at the top of the 
page, which is the browser default). This type of link is very useful for creating cross-
references on a page. 

Creating named anchor links is a two-step process: 

Step 1: Identify the location (on the page) to which you want to be able to link (called 
the named anchor). 

Step 2: Identify the location (on the page) from which you want to link and create the 
named anchor link. 

Step One: Identify the named anchor 
1. Bring the portion of your page to which you want to be able to link into view in 

the document window. 
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2. Place your cursor at the location were you would like to link. 

3. Click the Insert menu and choose Named Anchor. 

 

 

4. In the Named Anchor dialog box, type a name for this location. The name can be 
any word or words you choose, but for best results choose something meaningful. 
The name must begin with a letter or number, and may not contain any 
spaces. 

 

5. Click OK. 

This inserts an invisible element (anchor ) icon on the page. This icon will not appear 
on your published page on the Web. It merely serves as a placeholder while you’re 
working on your page. 

Step Two: Create the named anchor link 
1. Select the text that will serve as the link. 
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2. In the Property inspector, enter the URL in the Link field in one of these ways: 

• Type a pound sign (#) followed by the name of the anchor you used (this 
name is case sensitive, and must match exactly what you typed in the 
Anchor Name field previously): 

 

OR 

• Use the Point-to-File icon ( ) in the Property inspector: 

a. Click-and-hold the Point-to-File icon. 

b. Drag the mouse pointer to the yellow anchor icon ( ) that 
marks your desired named anchor, and release the mouse 
button. 

Email links 
An email link opens a new blank message window (using the mail program associated 
with the user’s browser) when clicked. In the e-mail message window, the To: field is 
automatically updated with the address specified in the e-mail link. 

To create an email link on your web page: 

1. Select the text or image you want to appear as the email link 

2. In the Link field of the Property inspector, type mailto: followed by an e-mail 
address. Do not type any spaces between the colon and the e-mail address. 

 

OR 

1. Select the text or image to serve as the link. 

2. Click the Insert menu and select Email Link. 
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3. In the Email Link dialog box, type the email address in the E-Mail field. 

 

4. Click OK. 

Removing links 
Regardless of the type of link (external, local, named anchor, or email), the method for 
removing a link is the same: 

1. Select the text or image that contains the hyperlink information. 

2. Highlight and delete the URL shown in the Link field on the Property inspector. 

3. Press Enter (or Return). 

Editing links 

To change the URL associated with a hyperlink: 

1. Select the text or image that contains the hyperlink information. 

2. Highlight and change the URL shown in the Link field on the Property inspector: 

OR 

1. Select the text or image that contains the hyperlink information. 

2. Browse to a different file name by clicking the folder icon. 

3. Press Enter (or Return). 

To change the clickable text associated with a hyperlink: 

Highlight and retype the text. 

Publishing a Page with Dreamweaver 
1. In the Files panel, click to select the files you want to put (publish). 

2. Click the “Put” button ( ). 

Dependent Files 
When you get or put pages, Dreamweaver may ask you whether you wish to include “dependent 
files.” Dependent files are any files needed by the web browser to render the web page correctly, 
such as images and stylesheets. When you “put” a page, if you have added an image or 
stylesheet to it, click “Yes” when prompted. 
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Editing Published pages in Dreamweaver 

“Get” Pages to Edit/Fix 
Get means downloading files so you can edit them. 

1. In the Files panel, click the Connect button ( ). 

2. Switch from Local View to Remote View, as shown: 

 

3. Click to select the files you want to get, and click the “Get” button ( ). 

Fixing Pages 
1. Switch to Local View. (Important: this step ensures that you are changing the 

copy of the page on your local computer, not on the web server.) 

2. Find the file you want to fix in the list and double-click it. The page will appear 
in the main (design) window of Dreamweaver. 

Here you can replace, rearrange, or add text; change or insert images; reorder 
lists; change or add hyperlinks; and much more. 

3. When you have made all the changes you want, click the File menu and click 
Save. 

If you make a mistake, you can click Edit and choose Undo. Note: Even if you save 
unwanted changes in the file, as long as you don’t “put” it, the published version on the 
web server won’t be affected. 

“Put” Fixed Pages 
Put means publishing a web page to the web server so that anyone in the world can 
access it. 

CAUTION: When you “put” pages that have already been published, you are 
overwriting the version of the page on the Web server with the version 
you’ve been working on in Dreamweaver 

1. In the Files panel, click to select the files you want to put (publish), 

2. Click the “Put” button ( ). 
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Additional sites and resources: HTML Info & Tutorials 
www.w3.org/ 

www.webmonkey.com/ 

http://www.htmlcodetutorial.com/ 

www.htmlgoodies.com/tutors/ 

Related Training Available from Instructional Services 
All workshops offered by Instructional Services are free to KU students, staff, faculty, 
and approved affiliates. 

To learn more about or register for workshops, receive automatic announcements of 
upcoming workshops, and track workshops you’ve registered for and have attended, visit 
www.infotraining.ku.edu. For further workshop related questions, please email 
training@ku.edu. 

Getting Additional Help 
IT Customer Service Center staff are available for computing assistance seven days a 
week. Call, email, or stop by in person at the Computer Center to get help. 

(785) 864-8080 
itcsc@ku.edu 
www.technology.ku.edu/~helpdesk 
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